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4. The Keyboard

A. 1. a 2. c 3. b

B. 1. number 2. space bar key 3. two.

C. 1. F 2. T 3. T

D. 1. The alphabet key are.......... on 

the keyboard. 2. Space bar key is the 

longest key in the keyboard. Enter 

key- There are two enter key in the 

keyboard. 3. Cursor is a small blinking 

.............. of  the typed text.

E. Do it yourself.

5. Learn To Use A Mouse

A. 1. b 2. a 3. a

B. 1. draw 2. single-click 3. Computer 

4. mouse-pad

C. 1. F 2. F 3. T 4. T

D. 1. Dragging the mouse ............. 

left button pressed. 2. Pressing and 

releasing the ........... called a double-

click. 3. Left button, Centre button, 

Right button. 4. We use the mouse by 

............ button is called clicking.

6. More Parts Of Computer

A. 1. Joystick 2. floppy 3. printer 4. 

Scanner 5. UPS

B. Do it yourself.

C. 1. T 2. F 3. T 4. F 5. T

D. 1.  Compact disc 2. Uninterrupted 

Power Supply

E. 1. Printer, Speaker, Joystick, 

Modem, Headphone etc. 2. Joystick is 

used to play games. 3. Printer helps 

you to take your works on paper. 4. It 

LOGIN HERE!-1

1. Introduction Of Computer

A. 1. c 2. a 3. b

B. 1. man-made 2. natural 3. electricity 

4. time

C. 1. F 2. T 3. T 4. T

D. 1. Air, water, flowers, .............. of  

nature things. 2. Machine are also 

man-made ........ in US different ways. 

3. A refrigerators is a machine that 

keep things cool. An air conditioner 

provides us cool air. 4. airports, hotels, 

offices, banks etc.

E. Do it yourself.

2. Computer: A Smart Machine

A. 1. b 2. a 3. c

B. 1. school 2. music 3. sums

C. 1. F 2. T 3. F

D. 1. You can play games on me. You 

can send and receive messages on me. 

2. Restaurant, Airport, Hotel, Shop. 

3. I remember many things., I never 

make mistakes., I work very fast.

E. Do it yourself.

3. Parts Of A Computer

A. 1. b 2. c 3. b

B. 1. VDU 2. Keyboard 3. Commands

C. 1. T 2. F 3. T

D. 1. CPU stands for Central.............. 

inside the CPU box. 2. A keyboard 

has many ........... on the keyboard. 3. 

A mouse has two or............ by using 

the mouse. E. Do it yourself.
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is very useful to store information. 5. 

UPS stands for .................. electricity 

goes OFF.

7. Starting Of Computer

A. 1. b 2. a 3. a

B. 1. F 2. T. 3. T 4. T

C. 1. damage 2. desktop 3. Start 4. 

icons 5. buttons D. Do it yourself.

E. 1. Switch ON the UPS system. 

Switch ON the ........... of  the monitor. 

2. Click on the START button .......... 

select Turn Off  computer. 3. UPS is 

used to supply ......... voltage or power 

failure.

8. Fun With Paint

A. 1. b 2. a 3. b

B. 1. Microsoft 2. Shapes 3. Eraser

C. 1. T 2. T 3. F

D. 1. Tools group, Shapes group and 

Colours group. 2. Ribbon and Tab 3. 

Step 1: Click on the Home tab......... a 

circle is drawn. 

E. (a) 1. d 2. c 3. b 4. a (b) and (c) Do it 

yourself

9. Manners In The Computer Lab

A. 1. c 2. b 3. c

B. 1. computer 2. monitor 3. keyboard 

C. 1. F 2. F 3. T 4. T

D. 1. Always form a queue to ........... 

in the computer lab. 2. Always cover 

the ............. cover after use. 3. It may 

harm our eyes. 4. On the mouse-pad

E. Do it yourself.

2. LOGIN HERE!

1. Computer An Electronic 

Machine

A. 1. a 2. c 3. c

B. 1. keys 2. CPU 3. printer 4. scanner 

C. 1. F 2. T 3. T 4. F

D. 1. Mouse 2. Monitor, keyboard, 

CPU and Mouse. 3. Sends and 

receives messages and helps in games. 

4. Computer: It is an electronic 

machine. Human being: It is not an 

electronic machine.

E. Do it yourself.

2. Uses Of Computer

A. 1. b 2. b 3. a 4. b

B. 1. cars 2. Weather 3. time table 4. 

diagnosing

C. 1. F 2. T 3. T 4. F

D. 1. Compute helps in........ cards in 

schools. 2. The computer helps you 

................ as online shopping. 3. The 

computer helps ................ Preparing 

medical report. 4. Computer helps at 

various .............. several other places.

E. Do it yourself.

3. Operating System

A. 1. c 2. b 3. b 4. a

B. 1. operating system 2. desktop 3. 

clicking 4. taskbar

C. 1. T 2. T 3. F 4. F

D. 1. An operating system is a ........... 

without an operating system. 2. Do 

yourself.3. A few second after ............ 

called the desktop. 4. Yes

E. 1. A single-user operating system 

............ Meant for home use. 2. You 

can change or move .......... the mouse 

button. 3. A file in Windows is similar 

.......... data, problems, etc. 4. Step 1: It 

shows a list of  ...................... off  your 

computer.

F. Do it yourself.
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D. 1. Yellow colour 2. Magnifier is 

used to ........ a freehand movement. 3. 

Eraser is used to .......... picture or text. 

4. Click on the curve in the ............. 

curve in the same way.

E. Do it yourself.

8. Introduction To Tux Paint

A. 1. c 2. a 3. b

B. 1. Eraser tool 2. toolbar 3. Tux 

paint

C. 1. F 2. F 3. T

D. 1. Drawing canvas 2. Tux paint is 

another ........... and easy to use. 3. To 

save your drawing .......... Your picture 

is saved.

E. Do it yourself.

9. Introduction To WordPad

A. 1. a 2. c 3. c

B. 1. Quick Access Toolbar 2. Text 

area 3. Cursor

C. 1. F 2. F 3. T 4. F

D. 1. Quick Access Toolbar: It is 

present ............ with just one click. 2. 

Cursor: It is a small white .............. of  

the typed text. 3. WordPad is a 

program of the .................. using the 

keyboard.

E. Do it yourself.

10. Looking After Your Computer

A. 1. c 2. a 3. b 4. a

B. 1. Shut down 2. CD, DVD 3. Dusty, 

hot, humid 4. Good

C. 1. T 2. F 3. T 4. T

D. 1. Use original software 2. Your 

computer will work much ....... look 

after it well. 3. Don't touch their 

........... pull it out yourself. 4. Protect 

4. Operating The Computer

A. 1. c 2. b 3. a

B. 1. icon 2. desktop 3. CPU

C. 1. After completing your work 

....... shut down the computer. 2. The 

first display screen ......... is called 

desktop. 3. The thin bar at the .......... 

called title bar. 4. The small picture 

...... are called icons. 

E. Do it yourself.

5. Keyboard And Its Function

A. 1. c 2. a 3. b 4. b

B. 1. Caps lock 2. return 3. Left arrow 

4. Delete

C. 1. T 2. T 3. T 4. F

D. 1. Press the Caps Lock key ......... 

type small letters. 2. Space bar key, 

enter key, caps lock key, arrow key, 

backspace key, delete key 3. The 

number keys are ........... Digits 0 to 9. 

E. Do it yourself.

6. More About Mouse

A. 1. c 2. a 3. a 4. b

B. 1. Douglas Engelbart 2. mouse 

pointer 3. Double-click 4. scroll

C. 1. T 2. F 3. F 4. T

D. 1. Take the mouse pointer......... 

menu will appear. 2. Drag and drop is 

......... want to place the cursor. 3. The 

slant arrow on ............. in the same 

direction.

E. Do it yourself.

7. More On Paints

A. 1. a 2. b 3. a

B. 1. fill with colour 2. curve 3. 

drawing area 4. title bar

C. 1. F 2. T 3. F 4. T
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ground picture of  ................ to their 

settings. 5. Operating system is a 

software that ................ MS DOS 

WINDOWS.

3. More On Paint

A. 1. a 2. b 3. a 4. a 

B. 1. Cut 2. Ctrl+S 3. Ctrl+O 4. Copy 

5. Curve

C. 1. F 2. F 3. T 4. T 5. F

D. 1. Curve shapes us used to draw 

................ can be made for a line. 2. 

Colour picker tool is a very ........ into 

any other object. 3. Select the copy 

command on the Home tab. Cut 

command removes the ................ be 

inserted anywhere. 4. On the home 

tab, click cut command ............... be 

inserted anywhere. 5. It is used to 

select a rectangle shaped area of  an 

image.

E. Do it yourself.

4. More About Keyboard

A. 1. b 2. b 3. b 4. a

B. 1. Alphabet 2. Special 3. Arrow 4. 

QWERTY

C. 1. F 2. F 3. T 4. F

D. 1. Alphabet keys, Arrow keys, 

Number keys, Special keys, Function 

keys, Navigation keys 2. Enter key 3. 

Function keys are used to ......... Help 

answer Support Centre. 4. Do not pull 

or push or push the ............... of  the 

keyboard too hard.

E. Do it yourself.

5. Microsoft Word 2013

A. 1. b 2. a 3. b 4. c 5. a

B. 1. Microsoft 2. Document area 3. 

Stats bar 4. Rules 5. Title bar

your monitor from ............... soft and 

dry cloth.

E. 1. Don't enter the computer room 

......... time through the day. 2. Protect 

your keyboard from dust ............ it 

might be harmed. 3. Protect your 

monitor from direct ........... a soft and 

dry cloth. 4. Do it yourself.

E. Do it yourself.

3. LOGIN HERE!

1. Basic Parts Of A Computer

A. 1. a 2. c 3. c 4. b 5. c

B. 1. storage device 2. processing 

device 3. commands 4. Software 5. 

System software

C. 1. F 2. T 3. T 4. T 5. F

D. 1. The physical parts of  a computer 

............ examples of  the hardware. 2. 

Motherboard, RAM and Micro-

processor. 3. The device which are 

used ......... storage device. 4. Software 

is the set of  program ............ System 

Software. 5. The software that helps 

you ........... application software. The 

software that controls ........... system 

software.

E. Do it yourself.

2. Window Operating System

A. 1. b 2. b 3. a 4. b 5. c

B. 1. Operating system 2. background 

3. taskbar 4. notification area 5. 

Maximize button

C. 1. F 2. F 3. T 4. T 5. T

D. 1. Notification area 2. The first 

screen appears with ............ is called 

desktop. 3. Icons are small picture that 

............ has an associative computer 

recycle bin network. 4. The back-
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E. Do it yourself. 

4. LOGIN HERE!

1. Computer System

A. 1. a 2. b 3. c 4. a

B. 1. CPU 2. Central processing 3. 

data 4. Joystick 5. Pen drive

C. 1. F 2. T 3. T 4. T 5. T

D. 1. It helps you to take the ....... and 

Laser printers. 2. Output device show 

the result of  the ......... monitor and 

printer. Monitor and speaker. 3. It is 

the main memory of  the .......... type - 

RAM and ROM. 4. The CPU has 

mainly thee parts: .................. of  a 

computer.

2. Working With Windows 7

A. 1. c 2. b 3. b 4. c

B. 1. Computer 2. cascading 3. task 4. 

Windows 7 5. save

C. 1. F 2. T 3. T 4. T 5. T

D. 1. Windows 7 has a very attractive 

............ quickly in our computer. 2. 

The area on the disk that ........... is 

known as a file. A folder is a place 

........... Contained in a folder. 3. Open 

Microsoft Word .......... This creates a 

new file. 4. Select the file or the 

............ dialog box appears.

E. Do it yourself.

3. Introduction To Multimedia

A. 1. a 2. b 3. a

B. 1. multimedia computer 

2. Microsoft 3. Multimedia 

4. autorun

C. 1. F 2. T 3. T

D. 1. It shows animation on screen 

.............. termed as multimedia. 2. 

C. 1. F 2. T 3. F 4. T 5. T

D. 1. You can change the size ........... 

margins of  the page. 2. Type file name 

in the file name box and click save 

button. 3. You can connect to a .......... 

online video button. 4. To start MS 

Word 2013, follow the .......... click on 

Word 2013. 5. Title bar: It appears on  

the top of  .................. with just one 

click. E. Do it yourself.

6. Log On To Logo

A. 1. a 2. a 3. c 4. c 5. a

B. 1. easiest 2. graphics 3. Recall list 

box 4. primitives 5. FD

C. 1. T 2. F 3. T 4. F 5. T

D. 1. The turtle is a small .................. 

only Logo commands. 2. HOME 

command is used to get ............... the 

Execute button. 3. Logo screen is split 

into ............ Commander Window. 4. 

Main screen shows the results .......... 

called graphics screen. 5. The LEFT 

or LT primitive is ................. rotate 

towards the left.

E. Do it yourself.

7. About Internet

A. 1. c 2. d 3. d 4. b 5. c

B. 1. Programs 2. VSNL, BSNL 3. 

HTML 4. chatting 5. E- commerce

C. 1. T 2. T 3. T 4. T 5. T

D. 1. The network connects .......... or 

units to the small. 2. The Internet, 

simply called ...... any other computer. 

3. Web site : A website is a collection 

on ............ it on the word wide web. 4. 

A Web browser is a software ............ 

Apple Safari etc. 5. This facility allows 

you to ........... in total privacy.
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6. Log On To Logo

A. 1. b 2. b 3. a 4. b 5. a

B. 1. Pause 2. Starts button 3. Sum 4. 

print 5. only one

C. 1. F 2. T 3. F 4. T 5. T

D. 1. LOGO is a simple programming 

............... arithmetic calculation. 2. 

The term lopping means ............... 

primitive for looping. When we use 

the REPEAT ............... LEARNING 

LOGO IS FUN. 3. Print is a very 

important ............... the commander 

window. 4. Do it yourself.

E. Do it yourself.

7. More on Internet

A. 1. c 2. a 3. c 4. a 5. a

B. 1. Word Wide Web 2. Uniform 

Resource Locator 3. Home page 

4. Internet 5. Microsoft Internet 

explorer

C. 1. F 2. T 3. T 4. T 5. F

D. 1. A hyperlink may be a text or 

............ of  a hand as shown. 2. Each 

website is identified by its unique 

............. bar of  a Web browser. 3. 

Internet is a very large network ........ 

World through the Internet. It allows 

us to send and .............. Internet and 

Web camera. 4. Information is put on 

the .............. and links to other pages. 

5. A Web browser is a software 

............ information available on the 

Web. Example of  some popular Web 

............ Firefox, Opera etc.

E. Do it yourself.

5. LOGIN HERE!

1. Development Of Computer

A. 1. a 2. c 3. a 4. a

listening music, watching movies 

............ to workers and students. 3. To 

install a multimedia CD ............ by 

following the instructions.

E. Do it yourself.

4. Ms Word 2013

A. 1. c 2. b 3. c 4. a

B. 1. ruler 2. storage device 3  CPU 4. 

ALU 5. Mother board

C. 1. T 2. F 3. T 4. F 5. F

D. 1. Making changes in a ............. 

called editing. 2. Formatting means 

changing and ............... group in the 

Home tab. 3. As we use a MS Word 

allows us ........... and format the text. 

4. Moving means to shift the text 

.............. and paste option. Copying 

means nothing but to ............. Copy 

and Paste Commands. 5. Title bar: It 

appears on the top of  the........... 

arranged in different groups.

E. Do it yourself.

5. Ms Power Point 2013

A. 1. b 2. c 3. c 4. b

B. 1. start button 2. slides 

3. information 4. slides show 5. note 

pane

C. 1. F 2. T 3. T 4. F 5. T

D. A presentation consists of  a 

number ............. to form a slide show. 

2. A presentation is a structure 

............ together on the screen. 3. A 

slide show is an electronic ......... using 

MS PowerPoint. 4. Click on the file 

tab ......... I  the Home tab. 5. The title 

bar is located at the ........... takes with 

just one click.

E. Do it yourself.
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insert a WordArt, follow the steps 

........... a beautiful change in the text. 

4. To insert Header, follow the steps 

given ................ Close group in the 

Design tab. E. Do it yourself.

4. Tables In Ms Word 2013

A. 1. b 2. c 3. a 4. b

B. 1. row 2. layout 3. Formatting table 

4. data

C. 1. c 2. d 3. b 4. a

D. 1. The vertical data is called a 

column. 2. Select the cell you want to 

............. select cells. Click on OK. 3. 

Click the Layout tab ............... 54 will 

be displayed. 4. Table style is used to 

change the look colour and design of  a 

table.

E. Do yourself.

5. Introduction to Ms excel 2013

A. 1. a 2. b 3. a 4. c

B. 1. Status bar 2. cell 3. formula 4. 

Autosum function

C. 1. T 2. T 3. T 4. F

D. 1. Spreadsheet is a system of  

recording ........ where data is entered. 

2. MS Excel is the most popular 

software that .............. Compare data 

through chart. 3. It appears on the top 

of  the screen ................ are sheet 1,  

sheet 2, and so on. 4. A cell is the space 

which is formed ............ cell C3 and 

extends till cell F12. 5. Click on file tab 

........... Quick Access Toolbar.

E. Do it yourself.

6. More on ms PowerPoint

A. 1. a 2. a 3. a 4. a

B. 1. Presentation 2. Slide 3. ppt 4. 

slide shoe

B. 1. Mark I 2. ENIAC 3. Laptop 4. 

Super computer

C. 1. F 2. T 3. F 4. T

D. 1. Abacus is the first known 

............ for doing calculations. 2. The 

computer you see today ......... lap and 

worked on. 3. Mainframe computers 

are large and much ..................... of  

mainframe computers. 4. They are 

used for doing very ............. examples 

of  super computer.

E. Do it yourself.

2. More Windows 7

A. 1. b 2. c 3. a 4. c

B. 1. Background, wallpaper 

2. gadgets 3. clock 4. weather

C. 1. c 2. d 3. a 4. b

D. 1. Let us learn some other ............. 

you may see your desktop. 

2. Windows desktop is the screen that 

............. background or wallpaper. 

3. Screen saver is a problem that ......... 

performing any operation. 4. The 

Windows contains mini programs 

........... Centre and WinZip gadget. 5. 

Change the background of  the ........... 

from the  hard disk.

E. Do it yourself.

3. More On Microsoft Word 2013

A. 1. c 2. a 3. a 4. b

B. 1. Symbols, special characters 2. 

Word art 3. Copy, effect 4. symbol 

dialog box

C. 1. T 2. T 3. T 4. F

D. 1. Picture makes a document more 

........... gallery known as Clip Art. 2. 

Shapes are the drawing features that 

......... impact to your message. 3. To 
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2. E-mail is a vert of  sending mails 

through the Internet. The e-mail is 

delivered .............. to the recipient. 3. 

Inbox: inbox is a folder which ........ 

you delete the selected message. 4. 

According to the physical distance 

.............. The Internet is an example 

of  a WAN. 

E. Do yourself.

LOGIN HERE!-6

1. Computer Languages

A. 1. b 2. c 3. b 4. a 5. b

B. 1. Program 2. Machine languages 

3. High level 4. Compilers 5. LISP

C. 1. F 2. F 3. T 4. T 5. T

D. 1. It is also called First Generation 

Language. 2. It is also called First 

Generation. It is the only language 

which computer understands. 3. A 

compiler translates the entire program 

in one go. 4. These types of  languages 

are closest to human language. It is 

user ........... any operating system. 5. 

It is also called First Generation 

Language. ................ It is also called 

Second Generation Language.

2. MS Word 2013 : Using Mail 

Merge

A. 1. b 2. a 3. c 4. a 

B. 1. Tab 2. Do it yourself  3. Data 

Source 4. Field 5. Viewing

C. 1. T 2. T 3. F 4. T 5. F

D. 1. Mail Merge is a feature which 

............ with the main document. 2. 

Data source contains mailing lists. 

.................. be inserted in the main 

document. 3. Data source contains 

mailing lists. For .................. address 

C. 1. T 2. T 3. T 4. F

D. 1. It is a part of  Microsoft Office 

Package ................. meeting and web 

page. 2. Installed themes are the ......... 

scheme and graphics effect. 3. Slide 

Sorter View button ....... one screenful 

at a time. 4. The default slide that 

appears ................ boxes called Place 

holders.

E. Do it yourself.

7. First step to the Internet

A. 1. a 2. a 3. a 4. b 5. c

B. 1. E-commerce 2. Modem 

3. website 4. surfing

C. 1. T 2. T 3. T 4. F

D. 1. The department of  Defence of  

the ............ Research Projects Agency 

Network. 2. Bharat Sanchar Nigam 

Limited (BSNL) ............. India (MTS 

India). 3. Microsoft Internet Explorer, 

Opera 4. Moving from one website to 

another is called surfing.

F. 1. A search engine can be defined 

............... (http:search.yahoo.com. 2. 

The individual pages that collectively 

from ............ and links to other pages. 

3. A modern is a device that allows 

.......... for Modulator Demodulator. 

4. Some uses of  the Internet are as 

follows ...... is known as E-commerce. 

G. Do yourself.

8. More about Internet

A. 1. a 2. b 3. b 4. a

B. 1. E-mail 2. Searching 3. Send 4. A 

WAN

C. 1. T 2. F 3. F 4. F

D. 1. It is very  helpful to people 

.............. your account and password. 
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5. Microsoft Excel 2013

A. 1. a 2. c 3. b 4. a 5. c

B. 1. Workbook 2. Worksheets 3. 

Formula 4. Range 5. Cell

C. 1. F 2. F 3. T 4. T 5. F

D. 1. Workbook is the first window 

which ............ it is named as Book 1. 

2. Cell: It is intersection of  a row and 

............. a cell that has the pointer. 3. 

A Workbook is similar to a notebook 

............. can add more worksheets as 

well. 4. For renaming a worksheet. 

............ new name and press Entre. 5. 

Do it yourself.

6. Learning to Edit a Worksheet

A. 1. b 2. a 3. c 4. c 5. a

B. 1. Home tab 2. Edit mode 3. 

Cancel and Entre buttons 4. Row or 

Column 5. Auto fill

C. 1. F 2. T 3. T 4. T 5. F

D. 1. Step 1: Choose the cell E7 and 

............. change to Ready mode. 2. 

Sometimes, after making changes to a 

cell, ............ undo our last action. If  

we wish to repeat the last .......... the 

Quick Access Toolbar. 3. To delete an 

entire row, ............. option from the 

menu. 4. Using Drag and Drop 

Method .............. the data has been 

moved. 5. Step 1: As an example, 

write Monday ............. will appear in 

the cells F2 to F7.

7. Algorithm and Flowchart

A. 1. c 2. a 3. b 4. a 5. b

B. 1. Flowchart 2. Algorithm 3. 

Decision 4. Start/Stop Box 5. Flow 

lines

C. 1. T 2. T 3. F 4. F 5. T

along with the main document. 4. 

Step 1: For creating a new mailing list. 

.............. under ‘Step 3 of  6’ section. 

5. Step 1: Click on the Finish & Merge 

................ separately along with the 

letter.

3. Microsoft PowerPoint 2013

A. 1. a 2. c 3. c 4. b 5. b

B. 1. Table 2. Table style 

3. Alignment 4. Top 5. Datasheet

C. 1. F 2. T 3. T 4. T 5. T

D. 1. Step 1: Click on New Slide drop 

arrow ........... columns and rows. then 

click OK. 2. Select rows/ocolumns 

/cells .......... (from drop down menu). 

3. Six alignment buttons are present 

on the .............. and Align Bottom. 4. 

Select table click Design .............. 

select a colour. 5. Chart is an efficient 

method for ........... any change in the 

data.

4. Animation of Text and Objects

A. 1. a 2. c 3. a 4. b 5. a

B. 1. Transition effects 2. Animation 

pane 3. Speaker 4. Animation 5. 

Audio

C. 1. T 2. F 3. T 4. T 5. T

D. 1. Animation is the ability to move 

........... using sound and visual effects. 

2. To adding sound from a file, ........... 

icon to play the sound. 3. Step 1: Open 

any of  four existing ............. over 

action buttons to see the action. 4. 

Step 1: Choose the desired slide and 

............. all your slides with the 

applied effects. 5. PowerPoint allows 

you to import ........... that you choose 

and applied.
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print to ............ used for printing 

tables. 3. This statement will multiply 

the values of  X ........ X$ = “HELLO”. 

4. Do it yourself. 5. It displays the 

values on after the other ......... printed 

on the next line.

10. Log on To Flash CS3

A. 1. b 2. a 3. c 4. b 5. a

B. 1. Stage 2. Menu bar 3. Timeline 4. 

Frames 5. Ink bottle

C. 1. T 2. T 3. T 4. F 5. T

D. 1. Flesh is an animation software 

package. ........... size without loss of  

clarity or quality. 2. The Stage: It is a 

rectangular .............. size is 550×400 

pixels by default. 3. Rectangle tool, 

Polystar tool and line tool. 4. It is 

useful for filling enclosed areas .......... 

the gaps in the shape outline. 5. Step 1: 

Select File - New option ........... frame 

rate and stage size.

11. Working with Flash CS3

A. 1. b 2. c 3. c 4. a 5. b

B. 1. Symbols 2. Shape 3. Library 4. 

Shape, Motion Guidetween 

5. Motion Guidetween

C. 1. T 2. T 3. F 4. F 5. T

D. 1. Symbol help to reduce the file 

size ................. Button, Graphic. 2. 

Instance is basically a copy of  the 

............... on the original symbol. 3. 

Whenever a series of  images are 

displayed at fixed .......... is known as 

animation. 4. Motion guide is used to 

define the path ........... invisible in the 

final animation. 5. Animations can be 

created with the ........ Motion Tween, 

Shape Tween.

D. 1. An algorithm is a set of  

sequential ............. easily understood 

by everyone. 2. Used for checking 

/applying a condition. 3. An 

algorithm is a set of  .............. easily 

understood by everyone. A flowchart 

refers to the pictorial .................. with 

each other via flow lines. 4. Used for 

taking input or giving output. 5. It 

used to connect the box in flowchart.

8. An Introduction to QB64

A. 1. a 2. a 3. b 4. b 5. c

B. 1. Variable 2. Brackets, 

Exponentiation. Division, 

Multiplication, Addition 

Subtraction. 3. Number 4. Brackets 

5. Print

C. 1. T 2. F 3. T 4. F 5. T

D. 1. QBasic was developed by 
Microsoft to type, ................. QBasic 
are called statements. 2. A named 
memory location which is used to 
store .................. variables are A1$, 
pkjh$, ASB2$. 3. Numeric Constants: 
Any number, that is integer or a ......... 
“Sneha”, “SUM=66”, “216726” etc. 
4. The sequence in which operations 
are .............. 68 this is the answer. 5. 
To save program, follow the given 
.................... be saved with extension 
.bas.

9. QB64 Statements

A. 1. a 2. b 3. a 4. b 

B. 1. Question 2. Table 3. Input 4. 

Numeric 5. CLS

C. 1. T 2. F 3. T 4. F 

D. 1. The INPUT statement used to 

take a ............ store it in a variable. 2. 

It is used to move the position of  the 
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D. 1. Step 1: Divide the decimal 

number ............ the quotient becomes 

zero. 2. The Binary Number is based 

only ............ convert the decimal data 

input to binary data. 3.  The Octal 

Number System is composed of  

............ only difference is in the base. 

4. The process for adding binary 

number inside the ............ addition of  

decimal numbers. 5. This number 

system contains ........... its base is 16.

2. Operating System

A. 1. b 2. a 3. c 4. b 5. b

B. 1. Hardware 2. One 3. UNIX, 

VMS 4. User, computer 5. CPU, 

mouse

C. 1. T 2. T 3. T 4. F 5. T 6. F

D. 1. The operating system is the most 

important program that .............. 

disk drives and printers. 2. The user 

interface aspect of  the ................ to 

communicate with the user. 3. A 

multi-user operating system allows 

.......... run at the same time. 4. 1940s, 

1950s and 1960s 5. Operating systems 

designers developed the ............... 

peripheral devices in use. With the 

development is LSI ............ Motorola 

6899 CPU family.

3. Taking Care of Your Computer

A. 1. a 2. b 3. a 4. b 5. a

B. 1. internal, external 2. turn off, 

unplug 3. dust, dirt 4. cables 5. clean

C. 1. T 2. T 3. F 4. T 5. F

D. 1. A dist scanner program is used 

............. some damaged information. 

2. The two mortal enemies of  the PC 

............. to their connectors on the 

12. Photoshop

A. 1. a 2. b 3. c 4. b 5. a

B. 1. Graphics 2. Painting tools 3. 

Digital cameras 4. Image window 5. 

Do it yourself.

C. 1. T 2. T 3. F 4. T 5. F

D. 1. Adobe Photoshop, or simply 

Photoshop, is .... or semi-transparent. 

2. Microsoft 3. Adjust colour 4. You 

can brighten, darken, and change the 

.............. styles to your images. 5. 

Understanding Pixels, Paint Your 

Image, Adjust Color, Apply Effects, 

Apply Filters, Add Text.

13. Internet Services

A. 1. a 2. a 3. b 4. a 5. c

B. 1. Network of  computers 2. Video 

conference 3. Chatting 4. Website 5. 

Forward

C. 1. F 2. T 3. F 4. F 5. T

D. 1. A signature is a presonalised 

text ............. every e-mail you send. 2. 

Nowadays, Internet offers us ........... 

of  our homes and offices. 3. Before 

using the e-mail facility to send 

messages, ......... some other required 

information. 4. Conversation between 

computers over the internet .............. 

messages through the internet. 5. 

Nowadays, it is even possible to 

perform bank transactions online 

......... to use E-banking services are:

LOGIN HERE!-7

1. Number System

A. 1. a 2. a 3. b 4. a 5. a

B. 1. 0-9 2. Position 3. 0-9, A-F 4. 0, 1 

5. Number system

C. 1. F 2. T 3. F 4. T 5. T
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6. Advanced Features of Excel

A. 1. a 2. b 3. b 4. c 5. c

B. 1. Updated 2. Category name 

3. Datasheet 4. Goal Seek 

5. Formatting the legend

C. 1. T 2. F 3. F 4. T 5. T

D. 1. Chart is an efficient method for 

............ any modification in the data. 

2. Chart Area: It includes complete 

area ............ Used for plotting values. 

3. Bar Chart: It is used to display the 

data in the ................ and the values 

along the horizontal axis. 4. Adding a 

Chart Title ............. click outside the 

chart. 5. Goal Seek is an amazing 

feature of  ................ adjusting a value 

in other cell.

7. Working With Flash CS3

A. 1. a 2. c 3. b 4. b 5. a

B. 1. Workspace 2. The stage 3. Menu 

4. Timelines 5. Timelines

C. 1. F 2. T 3. T 4. F 5. F

D. 1. Step 1: Click on Start button. 

.............. will open a new blank file. 2. 

It is a rectangular workspace area 

present at the ............ can be placed 

and animated. 3. Do yourself. 4. 

Gradient refers to filling colour in an 

............. colours in an object. 5. Step 

1: Click on File>Import>Import to 

.......... to be imported. Click on Open.

8. How Layers Work?

A. 1. c 2. a 3. b 4. c 5. b

B. 1. Layers 2. Pencil icon 3. File 4. 

Onion skin tool 5. Frame 60

C. 1. F 2. T 3. T 4. T 5. F

D. 1. Layers are used when we are 

.............. amongst different layers. 2. 

case. 3. To clean the keyboard, turn 

the keyboard ........... the dust by using 

compressed air. 4. Do it yourself. 5. If  

you use your computer everyday, ....... 

temporary windows less, and more.

4. Formulas and Functions in Excel

A. 1. a 2. a 3. b 4. c 5. a

B. 1. Basic 2. Cell reference 3. Three 

4. Functions 5. Variable

C. 1. T 2. T 3. F 4. T 5. F

D. 1. Formulas are used for doing 

calculations which .............. between 

multiple cells. 2. Step 1: Right click on 

the Sheet 2 tab in ................. of  your 

choice. Press Enter. 3. Multiple cells 

can be assigned to a ........... of  time 

and effort. 4. Absolute reference is 

used when the cell ............... or row 

number. For example, = $B$1+$B$2. 

5. Step 1: Functions should begin with 

= sign. ........... have arguments within 

them. For example, = AVERAGE 

(A1:A4).

5. Excel as Database

A. 1. a 2. a 3. b 4. c 5. a

B. 1. Database 2. Fields (columns). 

records (row) 3. Field 4. Field name 5. 

Data Validation

C. 1. T 2. F 3. T 4. F 5. T

D. 1. Database refers to a collection 

of  ...... according to the requirements. 

2. Sorting is the process of  arrange-

ment ............... data after sorting it. 3. 

This option filters the data in more 

........ location or finds unique records. 

4. Data Validation is required for 

................. within a given range. 5. 

Advanced filter option filters the ........ 

of  the specified criteria.
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GOSUB instruction can be used jump 

.......... returns to GOSUB instruction.

11. Graphics in QB64

A. 1. c 2. a 3. a 4. a 5. a

B. 1. PSET 2. LINE 3. Draw 

commands 4. QB64 programs 5. Paint

C. 1. T 2. F 3. F 4. F 5. T

D. 1. The SCREEN statement is used 

........... the screen resolution. 2. The 

DRAW command draws a ............... 

direction on the screen. 3. The 

coordinates x and y ........ to the colour 

code. 4. Step 1 : E-allows the pointer to 

draw ........... direction towards the left 

side. 5. The LINE statements helps to 

............ two points on the screen.

12. Service of the Internet

A. 1. b 2. b 3. c 4. a 5. c 6. a

B. 1. Internet 2. Micro blogging 3. 

140 characters 4. E-greetings 5. One 

drive

C. 1. T 2. F 3. T 4. T 5. T 6. F

D. 1. Nowadays, micro blogging is 

............... and other online mediums. 

2. Step 1: Go to your contacts list 

............. the Delete contact option. 3. 

A collection of  hardware, networks, 

............... configure or access online 

applications. 4. An area for discussion 

on a website .............. information is 

called a Forum. 5. Microsoft offers an 

online storage .......... make public or 

share with their contacts.

13. The Viruses

A. 1. a 2. b 3. c 4. a 5. c

B. 1. Virus 2. Vital Information 

Resource Under Seize 3. Virus 4. Anti 

Virus software 5. Refresh

Step 1: Simply click on the Insert 

Layer .......... name for the new layer. 

3. Step 1: Above the layers, Click the 

.............. on each red cross symbol. 4. 

Step 1: The layer which has to be ........ 

Step 6: Ok is clicked. 

9. Conditional Control Statements

A. 1. b 2. a 3. b 4. c 5. a

B. 1. Variable 2. Go to 3. Numeric 

variables 4. Control statements 5. 

Integer, real

C. 1. T 2. F 3. T 4. T 5. T

D. 1. The statements of  a program are 

......... performing conditional checks. 

2. When the GOTO statement is ........ 

loop that cannot be exited. 3. It is a 

conditional decision making ........... 

series with gap of  5 between 1 and 50. 

SRT: IF A < 51 ................. END. 4. 

Constants are defined as the ......... 

two types of  constants. A variable is 

named location in ............ can take in 

different values. 5. It is similar to 

INPUT statement. The ............. error 

message will be displayed.

10. Looping Statements

A. 1. b 2. a 3. c 4. b 5. a

B. 1. Go Sub 2. The for .....Next Loop 

3. 7th caracters 4. For ...Next 5. 

Starting, final

C. 1. F 2. F 3. T 4. F 5. T

D. 1. When we are writing a program, 

we ............ else loop is terminated. 2. 

Using a large number of  counter ........ 

PRINT SUM END. 3. Step 1: A 

control variable is taken ................ 

instruction after NEXT is executed. 4. 

Using one FOR....NEXT statement 

......... one is called inner loop. 5. 



14

an object or an item. 3. This is a filed 

or a combination of  ............ and also 

cannot be left blank. 4. Reduction in 

Data Redundancy: Data .................. 

in sharing data between different 

systems. 5. To create, modify and 

extract data ............ database manage 

-ment system.

3. Advanced Features of MS 

Access 2013

A. 1. a 2. c 3. b 4. a 5. b

B. 1. Form 2. Print preview 3. Four 4. 

Report 5. Print

C. 1. T 2. T 3. F 4. T 5. F

D. 1. The data that we create using 

............ school or the invoice bill. 2. 

To enter, edit and view data a .......... 

textboxes and labels. 3. Report view: 

This allows design related views only 

.............. change the size of  various 

controls here. 4. The query feature in 

MS ACCESS is used to get a .......... 

scored more than 60 percent marks. 5. 

To enter, edit and view data a form 

............ view like viewing the header 

and footer.

4. Introduction to HTML

A. 1. b 2. c 3. c 4. c 5. a

B. 1. Elements 2. Title 3. <HTML> 

4. HTML document 5. Linear

C. 1. T 2. F 3. F 4. T 5. T 6. T

D. 1. Some of  the HTML elements 

contain one or more ........... values of  

quotation marks. 2. An element is a 

fundamental ................. HTML text 

document. 3. Step 1: Click the Start 

button. ............ want to appear on the 

web page. 4. Do it yourself. 5. Do it 

yourself.

C. 1. T 2. F 3. F 4. T 5. T

D. 1. Spyware is a type of  malware 

which ........ without their permission. 

2. A worm is a type of  virus ........... 

and computer networks. 3. Boot 

Virses: These are the type of  ............. 

Disk Killer are some examples. 4. It 

can reformat the hard disk. ............. 

decreasing the computer memory. 5. 

They are the computer programs that 

............ an indication of  an infection.

LOGIN HERE!-8

1. Networking Concepts

A. 1. b 2. a 3. c 4. a 5. c

B. 1. Network Security 2. Hub 3. 

LAN 4. Network Topologies 5. Black 

hackers

C. 1. T 2. F 3. T 4. T 5. F

D. 1. Computers are used almost 

............. them so necessary in life. 2. 

Linking different computers to each 

............... other instead only a few 

chosen ones. 3. All computers in a 

network ........ the malicious software. 

4. A firewall protects the computer 

from .............. and the computer be 

protected. 5. This is basically a device 

that .............. the desired destination 

directly.

2. Introduction to MS Access 2013

A. 1. b 2. b 3. b 4. a 5. c

B. 1. Table design 2. DBMS 

3. Database 4. Access window 5. 

Object

C. 1. F 2. F 3. T 4. T 5. F

D. 1. Tables in access are also known 

as ........... form of  rows and columns. 

2. Records are rows in a table. .......... 
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B. 1. Visual Basic 2. Solution 

explorer 3. Visual basic 4. Visual basic 

5. Interactive Development

 environment.

C. 1. T 2. T 3. T 4. F 5. F

D. 1. You can create a calculator in 

...................... Add button: cmdAdd. 

Subtract Button: cmdsubtract ............ 

click on different buttons for viewing 

the result. 2. Visual Basic is a 

programming language that offers 

.................. a text based interface. 3. 

Visual Basic and QBASIC are ......... 

on graphical user interface. 4. Code 

view: To type code in visual basic we 

.............. controls using this view. 5. 

The different files of  a project are 

displayed by .............. code view or to 

designer view.

8. Introduction to Adobe 

Photoshop CS6

A. 1. c 2. c 3. b 4. a 5. b

B. 1. Selections 2. Colour

replacement 3. Magnetic Lasso 4. 

Painting 5. Crop

C. 1. T 2. F 3. F 4. T 5. T

D. 1. Step 1: Using the colour picker 

set the ............. picture the changes 

will be applied. 2. To draw shapes like 

rectangle, ........ shape just click and 

drag the mouse. 3. Step 1: Starting 

Photoshop is very easy .......... Click > 

Adobe Photoshop CS6. Step 4: 

Photoshop will open. 4. To make 

quick selections on the image we use 

............ mouse and click one the 

image 5. There are some parts in an 

image that are unwanted to ........... 

how to use the crop tool. This tool 

5. Inserting Image and Creating 

List in HTML

A. 1. a 2. a 3. c 4. b 5. c

B. 1. Ordered 2. Unordered list 3. 

SRC 4. Alt 5. <IMG>

C. 1. T 2. T 3. T 4. F 5. T

D. 1. Images in a webpage are used to 

enhance how the ........... of  designing 

the webpage. 2. These lists are 

numbered lists. They are ................ 

attributes are discussed below. As the 

name suggests ordered lists are not 

............ the items <L1> tag is used. 3. 

<F> This is used to mark the 

beginning of  a ......... before and after 

the text. Align 4. A numbered or a list 

of  proper order is known as an 

.............. the lists is known as nested 

list. 5. <IMG> tag has attributes like 

src, align, alt, height, width.

6. Creating Tables and Hyperlinks 

in HTML

A. 1. a 2. b 3. a 4. c 5. b

B. 1. Hyperlink 2. E-mail linking 3. 

Caption 4. Table 5. Table

C. 1. T 2. F 3. F 4. F 5. T

D. 1. When you surf  the internet you 

must ......... over the World Wide Web. 

2. External linking, Internal linking 

and E-mail linking. 3. You can link 

text to an e-mail address. To do this 

.......... href  attribute of  the <A> tag. 

4. <TABLE> tags define tables in 

HTML. 5. Rowspan is used to specify 

number of  rows a ................ or the 

<TD> or <TH> tag. <TD rowspan = 

“4”>.

7. Introduction to Visual Basic

A. 1. a 2. b 3. b 4. c 5. a
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B. 1. Movie 2. Transition 

3. Transition 4. Monitor 5. wmv*
C. 1. T 2. T 3. F 4. T 5. F

D. 1. Windows move maker is 

designed by ......... and also edit them. 

2. Do it yourself. 3. Step 1: Click on 

the file > same movie file ............... 

wizard on the screen. Step 5: Clicking 

on the finish button will complete the 

process. 4. They play a very important 

part in ................. by using the view 

menu. 5. This pane allows the user to 

perform functions ........... of  clip from 

the collection.

11. E-Commerce

A. 1. b 2. a 

B. 1. Customers, suppliers 2. Trade 3. 

E-commerce 4. Video conferencing 5. 

Mobile commerce

C. 1. T 2. T 3. F 4. T 5. F

D. 1. The term “electronic

allows us to use the .......... location on 

that image.

9. More Feature of Adobe 

Photoshop

A. 1. a 2. c 3. a 4. a 5. a

B. 1. Sharpen 2. Dodge 3. Blur 4. 

Clone stamp 5. Pattern stamp

C. 1. T 2. F 3. F 4. T 5. T

D. 1. Layers are used in Photoshop to 

work on ............. placed on a lower 

layer. 2. The appearance of  an image 

can be changed by ............... of  filters 

like stylize, render etc. 3. An image 

might be imperfect due to ........... us 

learn how to use this tool. 4. Dragging 

across the eraser tool .............. to the 

background colour. 5. These tools are 

used when images are to be .......... the 

burn tool will darken them.

10. Window Move Maker

A. 1. a 2. c 3. b 4. a 5. c
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